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i. INTRODUCTION

The DPEntryEZ™ Inspection Report Transcription Software was developed to help streamline the data
entry process for Drill Pipe/Tubing Inspection Reports. Before the introduction of this software,
handwritten inspection reports were manually entered into Microsoft Excel Spreadsheet Templates (the
document that is ultimately sent off to our customers). Due to the nature of the Excel Spreadsheets, and
the sheer volume of data columns, the consistent need of the Data Entry Specialist to shift their visual
focus between the handwritten report and the Excel Spreadsheet resulted in significant eye strain, and
extensive turnaround times for report completion. The purpose of this software is to eliminate this eye
strain, reduce keyboard strokes, and reduce the overall complexity of the process. It allows the user to
simply enter the values they see on the screen, one by one, until the report is complete. After the
inputting process is complete, the user then transfers that data to the Excel Spreadsheet
instantaneously.

N\
//j&\ Operator _E xample oP Date & Zz’lz"l

Contractor E:E?ﬁﬁ" CNT Field Invoice OO0\

PATH F I N DER Location _N 1D Page_ | of L_
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4 EML 240 [sER00Y |29
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Figure i-1- An Example Handwritten Report with 5 rows of joint data.
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Figure i-2 — The information from Figure i-1 correctly transcribed to the Microsoft Excel Report Template
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il. INSTALLING THE SOFTWARE

To Install DPEntryEZ™, double-click the install file (See Figure ii-1)

Mame h Date modified Type

E dpentryezdsetup 25/2024 3:10 PM Application

Figure ii-1-The DPEntryEZ 4.0 setup file

You will be prompted to enter a password before installing the software. This will be provided by your
administrator (See Figure ii-2):

— —

& Setup - DPEntryEZ version 4.0 —

Password
This installation is password protected.

//F_ \'l _('II
) ||
W = x

Please provide the password, then dick Next to continue. Passwords are case-sensitive.

Password:

Figure ii-2 — Password required for installation

Continue pressing the ‘Next’ button until the software successfully installs. Once completed, you should
have a Desktop Icon for the software (See Figure ii-3):

DPEntryEL

Figure ii-3 - The DPEntryEZ Desktop Icon
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1. GETTING STARTED

After receiving a (handwritten) report, you will be expected to return a completed Microsoft Excel
Spreadsheet. The first thing you will need to do is scan the physical report so that you can create a PDF
file of the report. In order for the PDF files to work with the software the files must contain a cover page as
their first page (See Figure 1a), followed by their accompanying data sheets (See Figure 1c and Figure
1d). Once you have scanned the report, it is a good practice to rename the file with some unique
identifying information, such as the Joint Count (See Figure 1b) This will be particularly helpful with
keeping track of multiple reports and using them within the software. You can rename the PDF file as you
wish, as long as it helps you keep track of the reports.

Inspection Summary

H\\\\\W//é
Operator _Epge mptain Date_12.-11-33
PATHFINDER Comectr—__ FieldInvoice _3sH§
INSPECTIONS & FIELD SERVICES Location Towtrieels Page 2 of _t]

Type of Inspection: TH B 8-, tod. 3 o bl AN y-finthiongimg

Connection Size and Type: 2% PL Total # of Joints Inspected: 179

Total Damages: __ 10 Total DBR:

Damage Seal: ( Box) ( Pin) Min Tong: ( Box) ( Pin)
Damage Threads: (_ | Box)(_4__ Pin) EMI:

Short Box: Damaged Tube:

Bent Tube: ~ MIN Wall:

Other:_ Slip (wh SQ-I-(\»-V Q) Other:

Total Refaces: Total Hardbands:

Pin: Pin:

Box: Box:

( [ql Repair Joints) (__~ DBRJoints) (= HBJoints) (_-  Repair/HB Joints)

Remarks:_41ip ¢t @godr [ e (\)
Q) a0t 27 PAL s,
Mise caps (15 o) (10pin)

Inspections done per TH-Hill DS-1 5th Edition Inspected by U_HJ. AD

* All damages marked in yellow with stencil or damaged at upset.

Doty Cnick Print Crckinon, MO

Figure 1a — An example of an Inspection Report Cover Page

-
PDF 179Row

Figure 1b - A Scanned PDF Report renamed using its ‘Total # of Joints Inspected’value.
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K (See Section 1.2)
5
: 25 Row A 3 HWDP-25 Type 1
8|
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0
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e PDPIR-253 Type 2
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7
| 18
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2 | ]
% | |
Connection Maximum Counterbore Recommended
Size & Type Pin ID __ Diameter (max.) Minimum Usable 0.0.
Inspectad by: i ._3\-\\\\1‘:,.;/;. Operator Date
. Contractor Field Invoice
Figure 1c — A Blank 25-Row Data Sheet PATHFINDER Location Page.___of
INSPECTIONS & FIELD SERVICES
] TUEllE o] uT | semae o TJBE e T | semaLe
1 26
2 27
3 28
4 29
5 30
] Eil
7 32
8 33
] 34
10; 35
1 36
12 37
Applicable Template Files for the 50-Row Data Sheet " .
. 15 40
(See Section 1.2) " »
17 42
13 44
23 Row » PDPIR-50 Type 2 ” ”
46
22 47
TUBING-30 Type 1 2 .
24, 49/
TUBING-50 Type 2 a .
D8 = Damaged Seal HE = Hardband Bux s8 f Short BOX CRf Cracked REI%_R‘eface Eﬂ.x
CASING-30 Type 1 O1h < o s iy KGOl (ool Mo bt Mt
;:’P; :::e:j:xpm g:a;:;::::::d;:ns LP = Long Pin UG = Uinder Gauge

Remarks: Inspections done per TH-Hill DS-1 5th Edition

Cannection Counterbore Maximum Recommended
Size & Type Diameter (max)_____ Pin ID Min. Usable OD. _____
Quatty Cnick P, [veirs, WD by

Figure 1d - A Blank 50-Row Data Sheet
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1.1 Uploading PDF Reports

After you have scanned and renamed your PDF File, you will then need to upload it into the software. If
you haven’t already, double-click the DPEntryEZ™ desktop item to run the software (See Figure ii-3). You
should be presented with the following window (See Figure 1.1a).

E CAUsers\CGData\AppData\LocalTemph_MEI33242\DPEntryEZ 4.0 BETA = O

File

Figure 1.1a - The initial window you are presented with when starting the software

To upload your PDF Report, go to the File Menu and select ‘Upload PDF’ (Figure 1.1b).
File
Upload PDF
Select Active Exc
Keyword Cheatsheet ’
Temnplate Select r

Write to Excel
Adjust The Template

7|Page Figure 1.1b - ‘Upload PDF’ option from the File Menu



You will then be prompted to select a PDF file to upload. Press ‘Open’ to upload the file (Figure 1.1c).
E Open

« = v |« 021D PEntryEZ- TexasVersion-Workthrough_3.1.2024 » Instruction Guide

Organize = Mew folder

v = USE(E) Mame . Date modified Type

BB 0.1 PF Softwan 7or S0RowExample 6/26/2024 11:17 AM Microsoft Edge P...
. 0.2 PF F"FI ort 1 Microsoft Elng P..
Ul \EDQO

Microsoft Edge P...
L Anatoly Fome ?

: Intreduction-HandwrittenExample_il Microsoft Edge P...
- BlenderToolloi - N n n ) .

ror PDPIRHWDPSubsComboCover 26, Microsoft Edge P...
B Compensatior
BB DPEntryEZ & 1
8 Financial
BB Heart River Prc
BB Install Files
B Machinel earn

File name: | 50RowExample ~ | | PDF files

[ !Jpr:"lk [ | cancel |

Figure 1.1c - File Dialog Menu allowing you to select a PDF file for upload (Uploading ‘50RowExample.pdf’)

The software may take a few moments to load the PDF, especially for larger reports. If you see a ~ (Not
Responding) indication, this means the PDF is uploading and that you just need to wait. You will know
that the PDF has been successfully uploaded when the PDF filename appears at the top right-hand
corner of the screen (Figure 1.1d).

50RowExample.pdf

Figure 1.1d — The PDF File has successfully been uploaded when you see it appear at the top of the
top right-hand portion of the screen.
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1.2 Selecting Your Template File

After your PDF file has uploaded, you will then be ready to select your Template File.

Template Files are one of the major key elements of the software. You can think of them as ‘windows’ that
allow the software to scan over each individual cell of the handwritten report — one by one. There are two
major template structures — 25 Row Templates and 50 Row Templates (See Figure 1c and Figure 1d).
Some report templates tend to have slightly different cell dimensions, requiring additional Template Files
for seemingly identical Report Templates. Finding the correct Template File to use may take some getting
used to. Luckily, the software has a feature built in that allows you to determine if you have selected the
correct Template File (See Section 3.4).

To Select your Template File, go to the File Menu and select ‘Template Select’. Here you will find the
various template options to choose from. Selecting any of these options will bring you to the next step -
Spreadsheet Creation.

File
Upload PDF
Select Active Excel
Keyword Cheatsheet »
Write to Excel 25 Row PDPIR-50 Type 2
Adjust The Template TUBING-530 Type 1
TUBIMNG-50 Type 2
CASING-50 Type 1

Figure 1.2a - Available Template Options for 50 Row Reports (Also See Figure 1d)

File

Upload PDF

Select Active Excel
Keyword Cheatsheet L

Template Select r 50 Row +

Write to Excel
Adjust The Template

HWDP-25 Type 1
HWDP-25 Type 2
HWDP-25 Type 3 - TX
PDPIR-25 Type 1
PDPIR-25 Type 2
PDPIR-25 Type 3- TX
TUBING-25 Type 1
TUBING-25 Type 2

Figure 1.2b - Available Template Options for 25 Row Reports (Also See Figure 1c)
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2. Creating a Spreadsheet

After you have uploaded your PDF file and selected your Template File, a new window will appear asking
you if you want to create a new spreadsheet (See Figure 2a).

# CA\Users\CGData\AppData\Local\Temp\_MEI33242\DPEntryE... — O X

Create Mew Spreadsheet?

Figure 2a - The ‘Create New Spreadsheet’ Window

2.1 When To Create A New Spreadsheet

There are only 2 main spreadsheet templates that we work with — Drill Pipe Inspection Reports and Tubing
Reports (Not to be confused with Template Files). When doing a Tubing Report you will always answer
‘Yes’to the ‘Create New Spreadsheet’ question.

Doing Drill Pipe Inspection Reports is a little more nuanced. This is because a single Drill Pipe Inspection
Report Spreadsheet can contain 1 or more of the following Tabs (Figure 2.1a):

Prop Drill Pipe Inp Report PDPIR Prop HWDP Inp Report HWDP Prop Subs Inp Report SUBS

Figure 2.1a - Drill Pipe Inspection Report Spreadsheet Tabs and their Shorthand-Reference Names
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Each of these tabs represents a slightly different type of report (for a different classification of
components). Even though they are technically different reports, they are often conglomerated together
into a single spreadsheet. This means that you may have up to 3 separate reports (distinguished by
having their own separate cover pages) that will all need to go onto a single spreadsheet. The
combination of Tabs can vary. They may only have a PDPIR Tab to complete. They may have a PDPIR Tab
and an HWDP Tab, or they may have a PDPIR Tab and a SUBS Tab. Below you will find an example of 3
Cover Page Headers — all which will be used to create a single Drill Pipe Inspection Report with 3 Tabs:
PDPIR, HWDP, and SUBS.

Prop Drill Pipe Inp Report

Inspection Summary

5\\\‘\\1 [////4

operator Macathon Date 6-26-24
PATHFIN DER Contractor HP 454 Field Invoice Q000 |
INSPECTIONS & FIELD SERVICES Location ND Page O of

Type of Inspection: TH-H\\ DsS-1 8™ Edhon CAT 3

Connection Size and Type: "1’0? XT-34 Total # of Joints Inspected: SD
Figure 2.1b - A Cover Page Header indication a ‘PDPIR’ Inspection Report (Tab)

Prop HWDP Inp Report

| Inspection Summary
@\\l//////,

M operator _Marethon Date 6-2(~24

PATHFIN DER Contractor Y HYSY Field Invoice G000 |

INSPECTIONS & FIELD SERVICES Location  ND Page O of

Type of Inspection: TH-thl] 05-1 5™ Edhen Qo+ 2= w/blucklght
!

Connection Size and Type: §" thoo? ¥-31 Total # of Joints Inspected: |2

FiguTeVZ. 1c - A Cover Page Header indication a ‘HWDP’ Inspection Report (Tab)

Prop Subs Inp Report

"7

Inspection Summary

gy
/‘,-A\ Operator Wacathon Date_ 6-2b '__,2_['{
C s i i
PATHFINDER ontractor _ Y9 M Field Invoice QOO0 |
INSPECTIONS & FIELD SERVICES Location N D Page O of

Type of Inspection: TH-Hll DS-1 €™ Edihon CATS

Connection Size and Type: So¥S Total # of Joints Inspected: 3

Figure 2.1d - A Cover Page Header indication a ‘SUBS’ Inspection Report (Tab). SUBS Tabs are done ‘manually’
(i.e. We enter this data manually into the spreadsheet)
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In Section 1.2, we went over selecting your Template File. This Template File not only tells the software
the structure of the Handwritten Report’s table structure, but it also implicitly encodes whether you are
aboutto complete a Tubing Report, a Prop Drill Pipe Inp Report Tab, or a HWDP Inp Report Tab.

Let’s assume that we just received a stack of reports. (Using Figure 2.1b, Figure 2.1c, and Figure 2.1d).
We proceed to scan all of these reports and rename them (As we did in Section 1- Getting Started). We
decide that we are going to first complete our PDPIR portion of the spreadsheet (Cover Page seenin
Figure 2.1b). We then upload our PDF File, and select the appropriate Template File. In this example, our
reportis a 50 Row , PDPIR Report (See Figure 1d). For this Report, our ‘PDPIR-50 Type 2’ Template File is
what we are going to use (we will explain why in more detail later) (See Figure 2.1e).

File
Upload PDF
Select Active Excel
Keyword Cheatsheet 4
Write to Excel 23 Row 4
Adjust The Template
Load Additional Pages

PDPIR-50 Type 1
TUBING-50 Type 1 A

TUBING-50 Type 2

CASING-50 Type 1

Figure 2.1e - Selecting the ‘PDPIR-50 Type 2’ Template File

After selecting your Template File (Figure 2.1e), we are then presented with our Create New Spreadsheet
window (See Figure 2a).

3. Prepping The Spreadsheet

3.1 Selecting Drill Pipe Inspection Report Tabs

Selecting ‘Yes’ to the Create New Spreadsheet window (Figure 2a) will result in a window being displayed
that allows us to begin filling out the Metadata of the Inspection Report. The Metadata is the data
displayed on the cover page that tells us some baseline information about the report (e.g. Customer
Name, Contractor Name, Date, Invoice Number, etc.)

If we selected a PDPIR or HWDP Template File, we are going to be presented with a Menu Selection (See
Figure 3.1a). Here we will need to select the checkboxes that apply. Since we have a PDPIR, HWDP and
SUBS report (Using Figure 2.1b, Figure 2.1c, and Figure 2.1d as our example), we are going to select all
three of the options and press the ‘Continue’ button (Figure 3.1b).

12|Page




NOTE: If we selected a TUBING Template File, this window will not be displayed. Instead, you will be
brought immediately to the Metadata Input Window (See Section 3.2)

# C\Users\CGData\AppData\Local\Temp\_MEI26842\DPEntryE... — O X

Which Tabs Will Be Included? (Select All That Apply)

Back Continue

Figure 3.1a - Drill Pipe Tab Selection Menu

# Ci\Users\CGData\AppDataLocal\Temp\_MEI26842\DPEntryE...  — O X

Which Tabs Will Be Included? (Select All That Apply)

Back Continue

Figure 3.1b - Drill Pipe Tab Selection Menu (Indicating that our spreadsheet will contain a PDPIR,
HWDP and SUBS Tab)
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3.2 The Metadata Input Window

The Metadata Input Window is where you will enter all the Metadata for the report. This information is
going to be used to ‘prep’ the spreadsheet - giving it a unique identity tailored specifically to the customer
and report type. This will prepare the spreadsheet so that you can begin entering the actual inspection
data.

The Metadata Input Window is going to display each relevant portion of the cover page in sequence, one-

by-one, where you will select from drop-down menus and/or enter text using text boxes. The first phase of
the Metadata Input Window will ask you to select an Operator from a Dropdown Menu (Figure 3.2a).

Phase 1 - Operator

§ C:\Users\CGData\AppData\Local\Temp'\_MEI177762\DPEntryEZ 4.0 BETA = a X

Marathon Cil

Figure 3.2a - Selecting your ‘Operator’ from a Drop-Down Menu

Move to the next phase by pressing the ‘Next’ button after you have made your selection (Figure 3.2a).
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Phase 2 will prompt you to enter in the Contractor Name. This will need to be entered in manually (See
Figure 3.2b)

Phase 2 - Contracto[

# C\Users\CGData\AppData\Local\Temp\_MEI177762\DPEntryEZ 4.0 BETA = O x

Figure 3.2b — Entering the ‘Contractor’

NOTE: When manually entering a value for the Contractor entry, make sure to be consistent with your
format. In the example above, we have the value ‘HP 454’. You want to make sure you always incorporate
a space in between the letter portion and the numerical portion. You would not want to enter in the value
‘HP454’. For abbreviated letters such as these (i.e. ‘HP’) Make sure to always use CAPITAL letters.
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Phase 3 will prompt you to enter the location. If this is left blank on the Handwritten Report, simply enter
in the abbreviation for your state (‘ND’, ‘TX’, ‘WY’, etc.). Make sure to use CAPITAL letters for State
Abbreviations.

Phase 3 - Location

t? C\Users\CGData\AppData\Local\Temp\_MEN77762\DPEntryEZ 4.0 BETA — O

Location

Figure 3.2c - Entering the ‘Location’
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Phase 4 will prompt you to select a date. Here, you will not need to manually enter the date, you can
instead select it from an interactive Calendar menu.

Phase 4 - Date

# C\Users\CGData\AppData\local\ Temp\_MEI177762\DPEntryEZ 4.0 BETA = O X

Figure 3.2d - Selecting your ‘Date’ with an interactive Calendar Menu

NOTE: Make sure you have your YEAR properly selected!

17|Page



Phase 5 prompts you to enter in the Invoice Number.

Phase 5 - Invoice Number

# CAUsers\CGData\AppData\Local\Temph,_MEI177762\DPEntryEZ 4.0 BETA O X

ield Invoice OO0 \

Figure 3.2e — Entering the ‘Invoice Number’
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Phase 6 will prompt you to select/enter information related to the Inspection Type. There are various
categories for inspections — all with varying degrees of specification. Most of the time, selecting from the
drop-down menu is sufficient (as seen in Figure 3.2f). Other times (particularly with Tubing Reports), you
will have to add additional information manually (See Figure 3.2g)

Phase 6 - Inspection Type

[ Ci\Users\CGData\AppData\Local\Temp\_MEI177762\DPEntryEZ 4.0 BETA

Type of Inspection: _TH-th\\ DS ™ gdidnmen CAT 3

I~ Actual OD's, ID's, and Tong Space I~ Additional Info

Figure 3.2f - A Simple ‘Cat 3’ (Category 3) Selection

W 0.2% 0161 ol
Type of Inspection: 4R FW S X Do) gl K, Y- fundion FXT
7

H-Hill DS-1Vol 3 CAT 3 - 5th Edition: Clean and Visual Ends w/Rattle and |

™ Actual OD's, ID's, and Tong Space ~ Additional Info , 4-Function EMI

Figure 3.2g - A ‘Cat 3’ Selection with ‘Rattle’, ‘FLD’ (Included in the Dropdown Item), and
‘4-Function EMI’ (Not included in dropdown selection — must me manually added)
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NOTE: When manually adding Inspection Type Info, you must begin your addition with a comma (,)
Phase 7 will prompt you to enter the Connection Size, Connection Type, and Grade Info (If applicable),
the Connection Size and Connection Type will be options selectable from a drop-down menu.

Phase 7 - Connection Size and Type

# CAUsers\CGData\AppData\Local\Temp',_ME 77762\DPEntryEZ 4.0 BETA = O X

Connection Size and Type: 1 pP X1-34

~ Add Grade Info

Figure 3.2h - Selection Menu for Connection Size (* 4" ) and Connection Type (‘XT-39’)
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Phase 8 is going to ask you for the Total Number of Joints Inspected. In Section 3.1, we showed how we
were required to determine which Spreadsheet Tabs would be included on the Inspection Report (Which
is only applicable for Drill Pipe Inspection Reports — Not for Tubing Reports). Since we selected all 3
options (PDPIR, HWDP, SUBS), this requires us to enter Joint Counts for each Tab. The Top Entry Widget
reflects the tab you are currently working on (Also reflected in your Template File selection —‘PDPIR’in
this example). Entering these values ensures the spreadsheet has the proper quantity of rows.

Phase 8 - Total Joint Count

E? Ch\Users\CGData"AppData\Local\Temp\_MEITT7762\DPEntryEZ 4.0 BETA - a pd

otal # of Joints Inspected: S O

# I:If HI.“Ier -ll:lintS: _
# I:If Su b -I i I ntS:

Figure 3.2i - Entering your ‘Total # of Joints Inspected’value(s). In this example, we enter Joint Counts for a PDPIR Tab (Top), HWDP Tab (Left)
and a SUBS Tab (Right)
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The final Phase 9 will ask you to enter the Inspector names/initials. These are the initials of the individuals
who performed the inspection out in the field. There are often more than one set of initials here. Simply
list each one of them, separating them using commas, and end the text with ‘and Crew’

Phase 9 - Inspected By

§ C\Users\CGData\AppData\Local\Temp',_MEI151322\DPEntryEZ 4.0 BETA = O *

CG and Crew

Figure 3.2j - A Single Set of Initials are seen in the ‘Inspected By’ region. ‘CG and Crew’ is written in the text field.

After pressing the ‘Next’ button, you will be prompted to select a location to save the updated Excel
Spreadsheet (See Next Section). At this point, the spreadsheet will be ready to have the inspection data
added to it.
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3.3 Saving The Updated Spreadsheet

After you have entered all the Metadata fields, a file dialog menu will appear asking you where you would
like to save the updated spreadsheet. You will notice that the filename has assumed various parameters
that we have entered during the Metadata Input process (This is the proper format that the Excel files
should be saved as). We will later use this same spreadsheet to add our HWDP and SUBS tab
information, so make sure you use an adequate saving procedure to help you keep track.

E Save As
&« = v A4 <« 021 DPEntryEZ-TexasVersion-Workthrough_3.1.2024 > Instruction Guide

Organize v New folder

MName . Date modified Type

ﬁ Home

B allan Mo iterns match your search.
& Gallery L

Chase - Render(

W Desktop
+ Downloads ;
E Documents ;
= Pictures

@ Music

File name:

Save as type:

1 Covp . -
» Hide Folders | Cancel

Figure 3.3a - File Dialog menu prompting the user to save their updated Spreadsheet File.
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3.4 The Calibration Window

After you have saved the Excel Spreadsheet, you will be shown the Calibration Window. This step is
necessary to ensure that the PDF file is displayed correctly. This is also the step that will allow us to
determine whether our Template File is going to “fit’ (See Section 1.2). The Red-Dotted Line Box (RDLB)
should fit almost exactly around the square box that is surrounding the 1" (See Figure 3.4b). If the RDLB
does not fit perfectly around the " 17, this will indicate that you have selected an incorrect Template File
(See Figure 3.4c). | # Calibration

- o X
| § Calibration - O X

INSPECTIONS . INSPECTIONS .
BOX BOX
oD oD

1 ...... & qq%oo | ' 1 & “'Q%OD |

Please reposition the red dotted-line box so that the '1' is centered

Please reposition the red dotted-line box so that the '1' is centered

Calibrate

Calibrate Figure 3.4b — The RDLB is properly positioned. Press
‘Calibrate’to proceed.

Figure 3.4a - Calibration Window. The RDLB is not
properly positioned

( 6 Calibration

= o x|
o
Holding your Left-Mouse I I" l rl l- If you find that your

button down will allow you WP e . Template File does not fit
et . INSPECTIONS . .
g the red-dotted line correctly, simply close out
box to the appropriate of the Calibration Window
location. Let go of your BOX ' | and re-select the correct
Left-Mouse button once | Template File, the
you have properly | 0 D Calibration window will
positionedthe RDLB. ||  fr=—= & qq reappear using the new
1 V‘o ° Template File

Please reposition the red dotted-line box so that the '1' is centered

Calibrate

Figure 3.4c - Size of the RDLB indicates an incorrect
Template File selection.
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3.5 Adjusting The Template

As you continue to enter report data, you may find that some of the later pages have become ‘skewed’.

This can happen when the pages in your scanned packet were tilted ever so slightly due to the document
feeder. If you find that your pages have become misaligned, you can use the ‘Adjust The Template’ option
from the File Menu. This option will pull up the Calibration Window again, using your current page as the

basis for the adjustment.

| & DAD.1 PF Software Worki0.21 DPEntryEZ-TexasVersion-Workthrough_3.1.2024\Run Files-Testing Ground\DPEntryEZ 3.0 BETA - o x

File
Upload PDF

T Select Active Bxcel
Keyword Cheatsheet
Template Select
Write to Excel

Adjust The Templte ) |

Load Additional Pages

@ Calibration

364RowNC50.pdf

l UNDO
PREV
PAGE

TestButton

Please reposition the red dotted-line box so that the '1' is centered

Calibr*&

Figure 3.5b - The ‘Adjust The Template’ Option
brings up the Calibration Window again, using
your current Page as the basis for the adjustment

File

Figure 3.5a - Page 3 of the Report is Skewed, Selecting the ‘Adjust The Template’ option will
allow you to adjust the alignment

Page Count: 3

I

PREV NEXT )
ROI ROI

REDO l
NEXT,
PAGE

f@ DAL1 PF Software Worl\0.21 DPEntryEZ-TexasVersion-Workthrough_2.1.2024\Run Files-Testing Ground\DPEntryEZ 3.0 BETA

364RowNC50.pdf

l UNDO
PREV
PAGE

TestButton

Page Count: 3

I

PRFI/ NEXT ’
ROT ROI

REDO I
NEXT,
PAGE

Figure 3.5¢c - The ‘Adjust The Template’ Option has been used to successfully re-align

P
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4. The Main Screen

After the Calibration Window, you will finally be ready for the Data Entry Process. Look at Figure 4a and

Table 1 to get familiar with its overall layout of the Main Screen.

r

& C\Users\CGData\AppData\LocalTemp'\_MEI198362\DPEntryEZ 4.0 BETA
File

50-Row-PDPIR_VAR-2.json A

Page Count: 1 G

PREV
PAGE

PREV NEXT ’
ROI ROI

Figure 4a — The Main Report Screen ready to begin entering data. See Table 1 for key
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Name

Template File

Table 1

Main Report Screen Elements

Description

Your Template File Selection will be displayed here.

PDF File

Current ROI

Prev ROI

Your Uploaded PDF Filename will be displayed here.

Your current/active ROI (Region of Interest). Whatever is displayed here should be
entered into your Entry Box (I)

The displayed region for the Previous ROI (Region of Interest)

Next ROI
Action Display

Page Count

The displayed region for the Next ROl in the sequence

This region will display the values currently recorded for the Previous ROI, Current
ROI, and Next ROI

This is your Page Count Display, it lets you know the active page number you are
currently on

ROl Name

This displays the name of your Current ROI

Entry Box
Undo Button

Redo Button

This is the box you will enter data into

Undo the last entry you made

Redo the last entry you undid

Prev Page
Button
Next Page
Button

Cycles you to the previous page, this will always place you on the ‘Page_Count’ ROI
(Where you are expected to enter the page number)

Cycles you to the next page, placing you on the ‘Page_Count’ ROI

Prev ROI Button Cycles you to the previous ROI (Previous ROl becomes Current ROI)

Next ROI Button Cycles you to the next ROI (Next ROl becomes Current ROI)

(See Section 5 - Understanding ROIs for a more in depth description of ‘ROI’s)

NOTE: Using the ‘Enter’ key while your cursor is placed within the Entry Box will cycle you to the next ROl
and save the data that was entered. If no data was entered, the ‘Enter’ key will behave in the same
manner as the Next ROl Button. Pressing the ‘Next ROI Button’ does not save your data, it only cycles
you to the next ROI. There is no hotkey for cycling to the previous ROI (You must press the Prev ROI
Button)




5. Understanding ROls

5.1 Column ROIls

What is an ROI? No, it’s not a Return On Investment (at least not in terms of the DPEntryEZ™ Software).
Instead, an ROl is a ‘Region Of Interest’. It is a snapshot (an image) of a specific cell within the Table that
is displayed on any given page. Pressing the Enter key (or the ‘Previous ROI’ or ‘Next ROI’ buttons) will
change the image you see in the ‘Current ROI Display’, as well as the images you see in the ‘Previous ROI
Display’ and ‘Next ROI Display’. The use of ROls gives the user the ability to quickly enter data by allowing

them to keep their eyes focused to a very narrow area — increasing accuracy and speed. Every ROl display

image has a name associated with it, and the name of that ROl is displayed on m [Table 1].

The ROI name tells you which Column
and which Row it is referencing.

Column Name Raw Number

Figure 5.1a - The ROl Name Formatting Reference

Structure
The Combination of the Page Count
] Operator Date
Indicator and ROl Name can tell you
exactly which cell you are Contractor Field Invoice
Location Page ]l of t‘L
| O:OX TUéE PIL:D ut SERIAL # Ogox TU]BE PINID ut SERIAL #
1|t *¥%eo 361 [SER 00 |2 Ef)e 20 [N et
2 240 o872 21@ 306 |uN 246 |
3 B 272 003 |28 294 || 246
M 241 oou! |2 205 | | w7y
5 > legq] | o0s e 246 | V 4221
6 234 006 |3 245 | N[Iv
7{e® . 205 o007 |32 300 |gER 032
Page Count: 1 a1 301 Q08 |3 3ol 033
9 - 244 { o09 |34 562 forial
N 10 244 ot 0 |35 275 03 S
BOX-OD_1 m 25| | on s A @S eac
I S - R sco 031
13 1 23 O\ |38 215 63 8
14 25 oY |39 BN gen 246 || 034
15 300 o\S | ) 266 oMb
16 30l L Ol |a 300| | ou)
17 210 Y o7 e 20l || vz
18 29\ [NKB 1876 |43 306 N
P 284 |NKC 244 |4 224 | | oun
20 22| N[k s 290 | | oM5
7 24 | NJA 46 z46 | | ouL
22 R les 240 [sER 022 |a7 20l | | &1
23 294 [5ER 623 |48 300 ou g
24 205 | | eed e 3006 ony
25 205 W/ 02Y s 300 056G

Figure 5.1b - Diagram showing how the Page Count and ROl Name refer to their respective cells
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5.2 The Page Count ROI

The first ROl Name you are presented with after completing the Calibration Window is the ‘Page_Count’
ROI. The software will start you off on the first page of the report and it will expect you to enter the value
1.

NOTE: Entering an incorrect page number will result in your data being written incorrectly to the
Spreadsheet. Pay Close Attention to this ROI!

[ E C:\Users\CGData\AppData'\Local\Temp\_MEN 64882\DPEntryEZ 4.0 BETA — (] b4
File

50-Row-PDPIR_VAR-2 json 50RowExample.pdf
3

Enter Page Number

(R
‘( iig PREV NEXT L"fi,fl )’
&OI Roa

Figure 5.2a - The Main Report Screen as seen after completing the Calibration Window, you are prompted to enter the page number (The
Page_Count ROl is displayed)

After entering the Page Number, you will then begin entering all the cell data for that current page. When
you arrive at the last cell for the page, the next page’s Page_Count ROl will be displayed, prompting you to
enter the next page number (2), the process then repeats for each page.
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5.3 The ROl Flow Diagram

When cycling through your ROls for any given page, they will follow a ‘Flow Pattern’. You will always start
at the first cell of the page (In this example is it ‘BOX-OD_1’), and will finish on the last cell of the page (In
this example it is ‘SERIAL_50’). The Diagram below is an illustration to give you a visual representation of
this ‘flow’. The Flow Pattern is specific to the Template File you selected and will not always follow the
exact same Flow Pattern. However, they will always follow the general pattern — Starting at the first row of
one column, and finishing on the last row of another column.

m

ODBOK *ru!ae P"‘D ur SERJAL # )on = = P"'ID Ut | SERIAL#
gasmm PAGE ! 2 ~ &4
2 2% 27 1140
3 Pl § 28 240
4 P 29 24
5 23K 30 21
6 IP 31 238
7 241 32 ik
8 MK 33 293
9 by 2] 34 A
10 pl*) 35 oK\ |
11 23 36 MR
12 MR 37 25
13 ) 38 pi i}
14 pr: & 39 2
15 oac 40 23
16 ps 41 >N
17 ~dY 42 23%
18 235 43 240
19 237 44 2
20 2 45 e 2
21 i 46 230,
22 b 47 2]
23 hy 48 247
2 235 49 23P

25 Mp . v

FINISH PAGE

\—JJ Page_Count ROI

Displayed Next

S—— /

30 | Pa ge Figure 5.3a — The ROI Flow Diagram. Showing how the ROI display cycles forward between each RO/



6. Keywords and Values

6.1 Understanding Columns and How They Work With Keywords and Values

In order to understand Keywords and Values, we first need to understand the nuances between the
different column types. There are several primary columns that are ‘universal’ — meaning that they will
accept keywords and values. The Primary Columns include Box-Type Columns, Pin-Type Columns, and
the Tube Column (There is only one) . See Figure 6.1a

BOX-0OD BOX BOX-HB-R
Box-Type BOX jr BOX [ ] BOX [Fe[ R |
Columns oD TUl o o
i S E—

: PIN-ID PIN PIN-HB-R
Pin-Type PIN HB[ R
Columns I FiN ; P —‘ ! 5

3E ID

Figure 6.1a - Various ROl Names for Box-Type and Pin-Type Columns.

The ‘SERIAL and ‘TYPE’ Columns (See Figure 6.1b) do not expect any keywords or any set of values.
Instead, they are simply ‘transplanters’ — meaning that they will copy and paste whatever you type in

them to the spreadsheet.

TYPE T SERIAL # SERIAL NUMBER

Figure 6.1b — Various Serial-Number Columns (which all function the same).

The ‘UT’, ‘OD’, ‘ID’, ‘TS-PIN’, ‘TS-BOX’ columns are value-only columns (Figure 6.1c). They expect
numerical values. You should never enter any Keywords into these columns.

oD 1S ) PIN | TS BOX

Figure 6.1c - The ‘OD;, ID’, ‘TS-PIN, and ‘TS-BOX’ Columns.

NOTE: The DPEntryEZ™ Software does not have a Data Validation Feature for value-only columns. This
means that you could enter in a value as meaningless as ‘PIZZA’, and it would still translate ‘PIZZA’ into
the spreadsheet. However, Primary Columns will not allow you to enter invalid keywords. For example, if
you enter in the value ‘DR’ when you meant to enter ‘DT’, the software will not record the data.
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6.2 Using The Keyword Cheatsheets

When first beginning to use the software, you may feel overwhelmed by the variety of keywords to choose
from. Because of this, a feature within the File Menu was added - the Keyword Cheatsheets (See Figure

|' # TUBING/CASING - Keyword Chart

INDICATOR

|
BlueBand
YellowBand
‘ Min Wall
| RW
PIT
Mashed Tube
Slip Cut

Slip Cut Repair
Gouge
TC

Bent Tube

- O x

KEYWORD

HB B!!
HY BH

”MAS HH
Hscn

Bent Damage Beyond Repair “BNTDBR”

No Drift
EMI Reject
Damaged Box
Damaged Pin
RETGLENLT

“NODRIFT”

HD BJ'J'
“D PH

Figure 6.2c - Tubing Reports Cheatsheet

6.2a).
File
Upload PDF
Select Active Excel
m DP/HWDP Cheatsheet
Temnplate Select r TUBING Cheatsheet
Write to Excel
Adjust The Template
Load Additional Pages
Figure 6.2a - Displaying the Keyword Cheatsheet Menu
¢ e - Keyword Chart - O
D ATOR ORD
D ge( L
D cad d >
Dver-Re ls DR
0 Damage
Dther D ga (Box/F JLF
Damaged Hardband DHE
dpand =
an 0 Centerpad BCF
DBR dband DBHE
Ong
sad Reconditio D
B Repa BVRF
0D 0D
Damageda DE DA
Dthe ) A
2 e : .
0 50
[ E H

Figure 6.2b - Drill Pipe Reports Cheatsheet (For PDPIR and HWDP)
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The reason the Keyword Cheatsheets were created was to help you remember which keywords are
acceptable by the software. Sometimes, Different Inspectors in the field will be in charge of the
paperwork, and their language for notating damages is slightly different compared to another inspector.
Let’s take a look at a real-world example from a Tubing Report

n Page I) of
Box__| PN uT SERIAL #
oD TUBE ID
26 212
27 232
28 29
29 a2y
30 37
3 231
32 opp N2
33 237
34 233
35 16p? " 2g
36 224

Figure 6.2d - Example Tubing Report Showing the
handwritten indication of ‘ODP’ (Outer Diameter Pitting)

Notice how ‘ODP’ is written twice within the Tube Column. If we look at our Keyword Cheatsheet (Figure
6.2c) for Tubing Reports, we see that ‘ODP’ is nowhere to be found. You may have to ask a manager about
what the indication is referring to. In this case, ‘ODP’ stands for ‘Outer Diameter Pitting’. This Indicator is
properly entered into the software as ‘PIT’. You will have to keep this in mind when entering your
keywords. With a little experience, you will begin to intuitively know what the actual software keyword is

for any given handwritten indicator.

A simpler example, where you would be able to discern this independently, would be a handwritten
indicator such as ‘EMI Reject’. The Tubing Keyword-Cheatsheet shows you that ‘EMI Reject’s keyword is

‘EMI.
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BOX |  PIN

oD TUBE ID o
794 |Gaisde®| 257 |2y
Chy ("R [315¢ 222

N 9
z :/5 T 3 ,/q e t “NODRIFT"
274 gl | 2)7 223 EM) Relect
6 /4 # 354 |22 D -

: ; amaged Box
27y m )Yy |37
Cyy WO 19y, 24/
7 %% A% |14Y
G 27z |26
7% Yopm (377 |23¢

Figure 6.2e - Showing example Tubing Report where ‘EMI Reject’ is written, and showing that ‘EMI’ should be
used as the software keyword



6.3 Weird Keyword Cases (‘Other’)

You may have noticed a few Keywords from the Keyword-Cheatsheet that appear a bit confusing. These
are the ‘OTH’, ‘ODAM’, and ‘OTHER’ keywords (These are only applicable in Drill Pipe Reports). Let’s go
over these in a bit more detail so you can understand when and how to use them.

Other Damage | "OTH" “OTHER”
Other Damage (Box/Pin) "ODAM" :
1 Figure 6.3b - ‘Other’ Keyword applicable for the ‘TUBE’ Column (Drill
Figure 6.3a - ‘Other’ Keywords applicable for the Box-Type and Pin- Pipe Reports Only)

Type Columns (Drill Pipe Reports Only)

The Report Spreadsheets do not contain columns for every single damage type in existence, but it does
have most of them (The ones that are most used). There are less-common scenarios where an indication
on the handwritten report does not have a software-keyword counterpart. In these rare cases, you will
need to use the ‘OTH’, ‘ODAM’ or ‘OTHER’ keywords in the software. In addition, you will need to take note
which one of these you are ‘pairing’ with the handwritten indicators. Let’s work through an example to
better understand this concept.

In Figure 6.3c, we have two non-typical handwritten indicators - ‘Smashed Box’ and ‘SW’ (Swelled Box).
We must decide which ‘Other’ keyword we are going to use for ‘Smashed Box’, and which ‘Other’ Keyword
we are going to use for ‘Swelled Box’. Your choice is arbitrary. The important thing to remember is which
"Other’ keyword is set to which handwritten indicator. If you decide to use ‘OTH’ for ‘Swelled Box’, the
remainder of the report should always use ‘OTH’ for ‘Swelled Box’, and ‘ODAM’ will be used for ‘Smashed

Box’ for the remainder of the report. We decide to use 'ODAM for
'Smashed Box' for the
Remainder of the Report
BOX I L uT SERIAL
oD TUBE ID "
PE [
1 |4ag-ysa Y43 -5y 339 |nag He3 %M
2 263 |vAT  26A63
= =\
3 [dsun (85} |99 |yne 29684
Sinsh
i&mj IN Juae.  (33g0
Figure 6.3c — Chart.showing ar'1 example p?iring of | 5 P 1%3 RS 3299
‘Other’ keywords with non-typical handwritten
indicators 6 193 |war (S4LE)
7 k YL 193 [wes 29103
8 4§ uan A% [nvhe 0%964
(9](5w 293 |was  290ua
10] 4ety-eq 290 |MaR 0343

We decide to use 'OTH' for
'Swelled Box' for the
Remainder of the Report

34|Page



After you have decided which ‘Other’ keywords to use, and you have finished your report, there will be
one more step you need to do. This will be one of the very few (if not the only) time(s) you will need to
open up the excel spreadsheet and make a manual change to it. This is going to involve renaming the
‘Other’ Column Headers to their appropriate names (See Figure 6.3e). In Figure 6.3d, a diagram is shown
which illustrates the connection between the ‘Other’ Keywords, their Column ROls, and their place in the
Microsoft Excel Spreadsheet (For a Drill Pipe Report)

'OTH’
['BOX-ID', 'BOX', 'BOX-HB-R']

'ODAM’
['PIN-ID', 'PIN', 'PIN-HB-R']

[ ]
1

% | c — | ™

=18 B # | =
51 & *.Emi L=l - zle=|2
= &&SmEESEE.Emn‘FE:x:QE
AR I E AR R R B ' '
'..JEEgNu'Utl::—_qummm__: ol
"""-'-ESEEI—E="]"‘“:££§:=MM=EWE
<l1zlz 3£12'—‘UEEE;0,°§;;;G:¢E
dEHHEHHARHEHEHHEEHEHEEHUEE ['TUBE']

= slslslslalzls1c)cs] = = =N = =N =N = =

=1 a o Al sl cEl= w
2] = alal2ls| Zl=l=|2|E2=]z]|2]|z|=|=|=]=]|=]|3&
sl B™ = el E h=0 -} )
o] @ QU:g =] = alal=

]

alo I |

|

'ODAM'’
['BOX-ID', 'BOX’, 'BOX-HB-R']

'OTH'
['PIN-ID', 'PIN', 'PIN-HB-R']

Figure 6.3d - Shows the connection between the ‘Other’ keywords, their Handwritten-Report Columns, and the Excel Spreadsheet Columns
(Drill Pipe Reports Only)

ojojoj1joji1jojojojojol]o ojojojojojojojojojolo

® | = — ] ™

2|e
= | = glo|x :,:_, 2l=|2
elz |2l <|2lE=|2]|2]2 3
= x| &| B clslE]lz]z|:= Flelel=z]lce]lalz
AHE I EEH I EHE BRI EHEHEE
le1zl= 5 s el 2 ez sl5 2lzlz2l2]2lel=s]l5]¢e]=]2]:
HHEAHEHEEHAEEI R HEHEHE I L LR
AR HE R ==z = 222 12 1222l e =]"
e | = 5 slalauls1c)E]) 5 =lelE1E1EJENE
THEHEEHHEE IR EEEE R
=1 5 =1 21 e L= - =
N = Ol E|E | s alo|=

Sla |z

Figure 6.3e — Showing how the ‘Other’ columns should be renamed after having used ‘OTH’ for
‘Swelled Box’ and ‘ODAM’ for ‘Smashed Box’. (Drill Pipe Reports Only)
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6.4 Multiple Keywords

You will find that often, there will be multiple keywords contained within a single cell. To record multiple
keywords, you must enter each keyword separated by a space.

;|
5
6
7

™ ot

a

Figure 6.4a - The keywords ‘OR’and ‘DT’
are seen in a cell from Row 7

[ LT B e WS I i - Temeiteennn-Senethraich L1 ton Dieee aes g drmunafi 8 shed LTI 1A | b -

E0-Row-PDPIR_VAR-2 json

Page Count: 3

‘( PAGE — NENT "I'“'*' ))
‘J:HJ T Rﬂ:f*

Figure 6.4b - The ‘OR’and ‘DT’ Keywords are properly entered (each keyword is separated by a single
space)

NOTE: Not using spaces in between keywords will result in a failure to record the information. In the
example above, if you were to enter ‘ORDT’, you would neither record the ‘OR’ or ‘DT’ keyword.
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6.5 Keyword-Value Pairs

Keyword-Value Pairs work similarly to Multiple Keywords in the sense that a single space is required in
between them. For each Keyword that has an associated value, the associated value must come
immediately after the Keyword it is referring to, separated by a space. Let’s look at a couple examples
to solidify our understanding of this concept.

16

~ LIE!
17| 500-4%9

18
[

Figure 6.5a - A Reface
Indicator and it’s Associated
Value along with a Hardband
Indicator

IR PF Saftvare Wory121 DPEninpbZ- e Version-Warkihiough_3.0 2024 un Files-Testing Ground D8EnirgE2 3.0 BETA - ] 5

364RoWNC50.pdf

Page Count: 3

TestButton '“\ Box a o D_1 7

(( PREV
PAGE
Mv NExT
ROI ROTI

Figure 6.5b — The Reface Indicator, It’s Value, and the Hardband Indicator are properly entered
into the Text Box, ready to be processed.
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Figure 6.5¢c - A Min Tong
Indicator with an associated
valueof " 7%’

BOX

oD

L)
26| (5842
I~

27 :ﬁ{..gﬁg

Figure 6.5e — A Shortbox
Indicator with an Associated
Value of *4.484" (See Figure
6.5f for explanation)
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'& DAO.1 PF Software Worki0.21 DPEntryEZ-TexasVersion-Workthrough_3.1.2024\Run Files-Testing Ground\DPEntryEZ 3.0 BETA — (m] x
File

50-Row-PDPIR_VAR-2.json

364RowNC50.pdf

Page Count: 3

PREV
€= P
L{)] ROI

Figure 6.5d - The Min Tong Keyword and Associated Value is Correctly Written in the Entry Box.
Notice how Fractional Notations must have a space in between the whole number and the
fraction (This is the only time a space is not used for separating keywords)

'& DAC.I PF Software Worki0.21 DPEntryEZ-TexasVersion-Workthrough_3.1.2024\Run Files-Testing Ground\DPEntryEZ 3.0 BETA — a *
File

50-Row-PDPIR_VAR-2json 364RowNC50.pdf

Page Count: 3

‘( -~ SB 4.484 fo, ))
PAGE y— T PAGE
‘ ROI ROI a

Figure 6.5f — Short Box Indicator and its Associated Value is Correctly Written in the Entry Box.
Notice how we have had to manually add " 4." before the " 484" value. Some Keyword Values take
on assumed whole numbers that are not explicitly notated. This is usually your ‘Connection Size’
from the Report Metadata (See Figure 3.2h)



7. Transferring Data To Excel

7.1 Using The Active Excel Feature

When it comes to transferring your entry data to the Microsoft Excel Spreadsheet, there are two primary
options you can use. When first using the software, you may want to give the ‘Active Excel’ method a try.
You can find this in the File Menu under ‘Select Active Excel’
File
Upload POF

Keyword Cheatsheet k
Template Select »
Write to Excel

Adjust The Ternplate

Load Additional Pages

Figure 7.1a - The ‘Select Active
Excel’ Option from the File Menu

The ‘Select Active Excel’ Option will prompt you to select a Microsoft Excel Spreadsheet from a file dialog
menu. After you select the Excel File it will open. At this point, anything you enter in the Entry Box is going
to transpose ‘live’ to the Excel Spreadsheet. This method is only recommended when first starting out
with the software, as it allows you to see exactly how keywords and values are written to a spreadsheet.
However, this feature should only be used for training purposes, as it defeats the overall purpose of the
Software (to increase the speed in which you can complete reports). This is because you ultimately have
to look at the spreadsheet to determine if you have entered the correct values or not. Using the ‘Select

Active Excel’ Feature removes the Action Display from your Main Report Screen ( E-[Table 1]) See Figure
7.1b and Figure 7.1c.

& D01 PF Saftware Work\021 DPEntryEZ-Ts igh_3.1.2024\Run Files Ground\DPEntryEZ 3.0 BETA - o x & DAL PF Software Work\021 DPEntryEZ-TesasVersion-Workthvough_3.1.2024\Run Fles-Testing Ground\DPEntryEZ 3.0 BETA - o x

File File

50-Row-PDPIR_VAR-2.json 364ROWNCS50.pdf 50-Row-PDPIR_VAR-2json 364RoWNC50.pdf

Page Count: 6 Page Count: 6
P BOX-OD_3 S o yroo BOX-OD_2|
]
‘gﬂl ROI
Figure 7.1b - Normal Main Report Screen (Action Display is Figure 7.1c - ‘Select Active Excel’ Feature is activated, and the
present) Action Display is removed
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7.2 Using The Write To Excel Feature

The Second Feature (and the recommended method) for transferring your report information is simply
called “Write To Excel” (Also found in the File Menu). This Feature does exactly what it says — it Writes the
data to the Excel File. Selecting this option will prompt you to select an Excel File from a file dialog menu.
After you select your Excel File, you will be shown a Confirmation Window (Figure 7.2b). Selecting ‘Yes’
will confirm the Writing process and transfer all your data to the Excel File.

File
Upload PDF
Select Active Excel Are You Sure You Want To
Keyword Cheatshest ’ Write Your Data To The Excel
Template Select * Spreadsheet?

Adjust The Ternplate l! =

| Load Additional Pages

Figure 7.2a - Selecting the ‘Write To

Excel’ Option from the File Menu Figure 7.2b — The ‘Write To Excel’ Confirmation Window.
Pressing ‘Yes’ will write the data, and the action cannot be
undone.

NOTE: It’s a good practice to use the ‘Write To Excel’ Option after completing each page of a report. This
will have the practical result of ‘Saving’ your progress. The DPEntryEZ™ software does not save your work
automatically.
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8. Overwriting Values

Version 4.0 BETA of the DPEntryEZ™ Software is designed in a very peculiar way to allow it to do its job.
This design allows for the fast recording of inputs but has one weak point. This weak point has to do with
Overwriting Values that you have already recorded. You may find yourself in a situation where you have
entered an incorrect value, and you need to go back and change that value. There is a very specific way
you must do this to ensure continuity within the software. Let’s look at the following example. (See Figure

88) '& DAO.1 PF Software Work\0.21 DPEntryEZ-TexasVersion-Workthrough_2.1.2024\Run Files-Testing Ground\DPEntryEZ 3.0 BETA = o X
File

50-Row-PDPIR_VAR-2json 364RowNC50.pdf
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Figure 8a - Example where an incorrect value has been typed. " 640" has been entered
where " 340" should have been written.

To properly correct the mistake, you must use the ‘UNDQO’ button. The ‘UNDO’ button will undo the entry
and cycle your Current ROI Display to UT_1, allowing you to re-enter the value.

& DAQ.T PF Software Work\0.21 DPEntryEZ-TexasVersion-Workthrough_3.1.2024\Run Files-Testing Ground\DPENtryEZ 3.0 BETA - o x
File

50-Row-PDPIR_VAR-2.json 364RoWNC50.pdf

Figure 8b- The user has pressed the UNDO
button, and effectively erased their
incorrect entry, allowing them to enter the
proper value without issue.
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